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CALIBRATION PROCEDURE

NI PXle-6672

This document describes how to write a calibration procedure for the
10 MHz oscillator frequency of the NI PXIe-6672 timing and
synchronization module.
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Conventions

The following conventions apply to this document:

» The » symbol leads you through nested menu items and dialog box options
to a final action. The sequence File»Page Setup»Options directs you to
pull down the File menu, select the Page Setup item, and select Options
from the last dialog box.

This icon denotes a note, which alerts you to important information.

A This icon denotes a caution, which advises you of precautions to take to
avoid injury, data loss, or a system crash. When this symbol is marked on a
product, refer to the Read Me First: Safety and Radio-Frequency
Interference for information about precautions to take.
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Software

When symbol is marked on a product, it denotes a warning advising you to
take precautions to avoid electrical shock.

When symbol is marked on a product, it denotes a component that may be
hot. Touching this component may result in bodily injury.

Bold text denotes items that you must select or click in the software, such
as menu items and dialog box options. Bold text also denotes parameter
names.

Italic text denotes variables, emphasis, a cross-reference, or an introduction
to a key concept. Italic text also denotes text that is a placeholder for a word
or value that you must supply.

Text in this font denotes text or characters that you should enter from the
keyboard, sections of code, programming examples, and syntax examples.
This font is also used for the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names, functions, operations,
variables, filenames, and extensions.

Italic text in this font denotes text that is a placeholder for a word or value
that you must supply.

This calibration procedure requires NI-Sync and NI-VISA. NI-Sync and
NI-VISA support a number of application development environments
(ADEs) and programming languages, including LabVIEW,
LabWindows™/CVI™, and Microsoft Visual C++. When you install the
drivers, you need to install support for only the ADE or programming
language you are using. The illustrations in this document show the
LabVIEW code for implementing calibration steps using NI-Sync and
NI-VISA.

Documentation

You need the NI-Sync User Manual to calibrate the NI PXIe-6672.

The NI-Sync User Manual contains detailed information about using

the NI-Sync driver, including information about installing NI-Sync and
creating applications that use the NI-Sync driver. These sources, along with
this document, are your primary references for writing your calibration
utility. You also can refer to the documentation for the programming
language or application development environment you are using. For
further information about the device you are calibrating, refer to the

NI PXIe-6672 User Manual.
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Calibration Interval

Password

The measurement requirements of the application determine how often you
should calibrate the device to ensure its accuracy. National Instruments
recommends that you calibrate the NI PXIe-6672 yearly. You may want to
shorten this interval based on the application demands.

The default password for password-protected operations is NT.

Test Equipment

Calibrating the NI PXIe-6672 requires the following equipment.

Equipment

Recommended Model

Requirements

10 MHz clock source

Symmetricom/Datum 8040

Accurate to within
150 parts-per-billion (ppb)

BNC-SMB cable

SMB-SMB cable

Test Conditions

Follow these guidelines to optimize connections and test conditions during

the calibration procedure:

» Install the NI PXIe-6672 in the system timing slot of the PXI Express
chassis. The calibration procedure requires features of PXI that are
accessible only in the system timing slot.

*  Maintain a temperature of approximately 25 °C.

*  Keep relative humidity below 80 percent.

»  Use shielded copper wire for all cable connections to the device.

*  Allow a warm-up time of at least 15 minutes for the NI PXIe-6672 to
ensure the measurement circuitry is at a stable operating temperature.

*  Keep PXI chassis filters clean and fan speed set to High.

© National Instruments Corporation 3
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Calibration Procedure

The steps used in the calibration procedure are as follows:

1.

2.
3.
4

Initial Setup

Initial setup.
Verification.
Adjustment.

Reverification.

Complete the following steps to set up the NI PXIe-6672 for calibration.

1.

Verification

Make sure all components involved in the calibration procedure are
powered off.

Install the NI PXIe-6672 board into the system timing slot of your
chassis.

Power on the PXI chassis first, and then the external equipment.

Make sure that all the appropriate driver and application software is
installed on the host computer.

Configure the hardware with Measurement & Automation Explorer
(MAX). Refer to the NI PXIe-6672 Installation Guide for details about
configuring the PXI equipment.

The following steps outline the procedure for measuring the 10 MHz
oscillator frequency on the NI PXIe-6672 and determining whether the
device requires adjustment to meet the published specifications.

Connecting the Clock Source

1.

Connect the accurate 10 MHz source to the ClkIn connector on the
NI PXIe-6672.

Program the NI PXIe-6672 to route the ClkIn signal to PXI_Clk10In
without using its 10 MHz PLL by completing steps a—d.

@ Note Use the data in the C function call reference as inputs to your LabVIEW VI where

applicable.

NI PXle-6672 Calibration Procedure
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a. Call niSync Initialize VI to set up a handle for the device.

LabVIEW Block Diagram NI-SYNC C Function Call
Call niSync_init with the following
j&u’rce name ”"_ I— inztrument handle out parameterS:
a _cal resourceName: Dev1l
idQuery: NULL
resetDevice: VI_TRUE
e b m o

vi: ¥*SessionHandle

b. Set a writable NI-Sync property node to pass FALSE to the
Use PLL? attribute.

LabVIEW Block Diagram NI-SYNC C Function Call

Call niSync_SetAttributevViBoolean
with the following parameters:

relff;ence i reference oul
vi: “<SessionHandle>"
Propetty Node I terminalName: **
BT in) A = niSync b attributelD:
= 9 =
P UsePLL? NISYNC_ATTR_CLKIN_USE_PLL
attributeValue: vI_FALSE
Clk. Properties:LUse PLL? 55|

c. Call niSync Connect Clock Terminals VI to connect ClkIn to
PXI_CIk10_In.

LabVIEW Block Diagram NI-SYNC C Function Call

Call niSync_ConnectClkTerminals
niSync Connect Clock T eminals. vi with the following parameters:

instrument handle in

zource terminal
Clkin =

destination kerminal

- Vi: “<SessionHandle>"
inztrurent handle out .
sourceTerminal: NISYNC_VAL_CLKIN
destinationTerminal:

NISYNC_VAL_CLK10

eror in [no error
[E=ck beceveed Fra s |
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d. Call niSync Close VI to close the handle.

LabVIEW Block Diagram

NI-SYNC C Function Call

instrument handle in|

Call nisync_close with the following
parameter:

vi: “<SessionHandle>"

rezet device

error ault]
Foat

I, ;
errar in [na erar B p5 |
Measuring the Frequency
Complete the following procedure to measure the frequency of the onboard
clock source.
1. Connect the ClkOut terminal to the PFI O terminal by using an
SMB-to-SMB cable.
2. Complete steps a—d to program the board to connect the onboard
oscillator to ClkOut. Be sure to use the high-gain setting for clock out.
a. Call niSync Initialize VI to set up a handle for the device.
LabVIEW Block Diagram NI-SYNC C Function Call
Call nisync_init with the following
resourcs hame [ instrument handle out parameters:
BT

resourceName: Dev1l
idQuery: NULL (ignored)
resetDevice: VI_FALSE
vi: *SessionHandle

b. Seta writable NI-Sync property node to pass TRUE to the ClIkOut
Gain Enable attribute.

LabVIEW Block Diagram

NI-SYNC C Function Call

Property Mode

reference oul

_i—
&

errar in| B piSpnc D
[==:4 Pk 0t Gain Enable

.
Clk Properties: ClkOut Gain Enable]

Call nisync_SetAttributeViBoolean
with the following parameters:

Vi “<SessionHandle>"
terminalName: “*

attributelD:
NISYNC_ATTR_CLKOUT_GAIN_ENABLE
attributeValue: vI_TRUE

NI PXle-6672 Calibration Procedure
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c. Call niSync Connect Clock Terminals VI to connect the oscillator

to ClIkOut.

LabVIEW Block Diagram

NI-SYNC C Function Call

instrument_ handle in

ris

HI-=

nc Connect Clock, Terminals. vi]

instrument handle ool

zource terminal

Oscillator ~

destingtion berminal

&Iror in (o error ermor out

=it S|

Call niSync_ConnectClkTerminals
with the following parameters:

Vi: “<SessionHandle>"
sourceTerminal:
NISYNC_VAL_OSCILLATOR
destinationTerminal:
NISYNC_VAL_CLKOUT

d. Call niSync Close VI to close the session handle.

LabVIEW Block Diagram

NI-SYNC C Function Call

instrument handle in

rigync Cloge. vi
[=]

[ —

error in [ho erraor ooy b5

Call niSync_close with the following
parameter:

Vvi: “<SessionHandle>"

3. Complete steps a—c to measure the oscillator frequency through PFI 0.

a. Call niSync Initialize VI to set up a handle for the device.

LabVIEW Block Diagram NI-SYNC C Function Call
Call niSync_init with the following
Iesource name [ irstrurnent handle out parameters:
resourceName: Devl
S— idQuery: NULL
_= resetDevice: VI_FALSE

vi: *SessionHandle

© National Instruments Corporation
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b. Call niSync Measure Frequency VI to measure the frequency of
the oscillator.

LabVIEW Block Diagram NI-SYNC C Function Call

Call nisync_MeasureFrequency with
the following parameters:

rigync Measure Frequency.vi

instrument handle out Vi: “<SessionHandle>"

T/0 .
inztrument handle sourceTerminal:
NISYNC_VAL_OSCILLATOR
duration: 0.5
0.5 actualDuration: *actualbDuration
_ measuredFrequency:
g |:1 m *measuredFrequency

error: *error

c. Call niSync Close VI to close the session handle.

LabVIEW Block Diagram NI-SYNC C Function Call

Call nisync_close with the following
parameter:

instrument handle in|

niSvnc Cloze. vi

vi: “<SessionHandle>"

o i : § o |emor oul
erroi it [ho ermrar By B 55 |

4. Compare the measured frequency to the device specifications.

To determine if the device under test meets its specifications, you must
compare the measured frequency obtained in Step 3 of Measuring the
Frequency with the specified accuracy. Table 1 shows the frequency range
that is acceptable according to the published specifications for the

NI PXIe-6672.
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Table 1. Acceptable Frequency Ranges

Acceptable Frequency Range

Specified
Device Accuracy Low Limit High Limit
NI PXIe-6672 +2.5 ppm 9,999,975 Hz 10,000,025 Hz
(TCXO)
If the measured value is within the low-limit and high-limit range listed
under the Acceptable Frequency Range, the board is calibrated correctly.
Adjustment

If the accuracy of the 10 MHz oscillator is outside the specified range for

the product, the device is out of calibration. A programmable voltage

controls the oscillator frequency. By varying this voltage and precisely

measuring the frequency, you can find a voltage that gives a frequency as

close as possible to 10 MHz.

1. Complete steps a—c to set the oscillator control voltage. The range
of acceptable voltage values is 0.0 V to 4.095 V with frequency
increasing as voltage increases. Use a control voltage of 2.0475 V,
which is in the middle of the valid range, as a starting point.
a. Call niSync Initialize VI to set up a handle for the device.

LabVIEW Block Diagram NI-SYNC C Function Call
Call niSync_init with the following
esource hame (] instrument hardle out parameters:
[abcky

Teset device

:
et

resourceName: Devl
idQuery: NULL
resetDevice: VI_FALSE
vi: *SessionHandle

© National Instruments Corporation
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b. Set a writable NI-Sync property node to pass the constant 2.0475
to the Oscillator Voltage attribute.

[Calibration Properties: Ozcillatar Valtage]

LabVIEW Block Diagram NI-SYNC C Function Call
Call nisync_SetAttributeViBoolean
Iference in Per— with the following parameters:
Vi: “<SessionHandle>"
Froperty Mode _J— t inalN Cwn
eror in Bt piSprc D ern.nna ame:
. i - attributelD:
NISYNC_ATTR_OSCILLATOR_VOLTAGE
2.0475 oozl attributeValue: 2.0475

c. Call niSync Close VI to close the session handle.

LabVIEW Block Diagram

NI-SYNC C Function Call

instrument handle iny

niSvne Cloze. vi

HI-;

Call nisync_close with the following
parameter:

vi: “<SessionHandle>"

rezet device

= bEaL |

(5 :
error in [na ermor s e
Proceed with the following steps to find the correct oscillator control
voltage.
2. After setting the control voltage, measure the frequency again with the
NI-Sync Measure Frequency VI to measure PFI 0, as shown in Step 3
of the Measuring the Frequency section.
Complete steps a—c to measure PFI 0.
a. Call niSync Initialize VI to set up a handle for the device.
LabVIEW Block Diagram NI-SYNC C Function Call
Call nisync_init with the following
resource name [ instrument handle out parameters:
(LTS o

resourceName: Devl
idQuery: NULL
resetDevice: VI_FALSE
vi: *SessionHandle

NI PXle-6672 Calibration Procedure
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b. Call niSync Measure Frequency VI to measure the frequency of
the oscillator.

LabVIEW Block Diagram

NI-SYNC C Function Call

instrument handle out

I/

instrument handle
- e asured frequehc
duration £
¥

05
Ermor in ermor out

Fai b pEIT

Call niSync_MeasureFrequency with
the following parameters:

Vi: “<SessionHandle>"
sourceTerminal:
NISYNC_VAL_OSCILLATOR
duration: 0.5

actualDuration: *actualDuration
measuredFrequency:
*measuredFrequency

error: *error

c. Call niSync Close VI to close the session handle.

LabVIEW Block Diagram

NI-SYNC C Function Call

inztrument handle iny

[ —

jerror in [no error Bocon b5 o

Call niSync_close with the following
parameter:

Vi: “<SessionHandle>"

Compare the measured frequency to the device specifications.

4. If the measured frequency is still outside of the specified limit, repeat
steps 1-3 of the Adjustment section until the measured value falls
within the acceptable frequency range for your module, as shown in
Table 1, Acceptable Frequency Ranges.

5. Commit the calibration values to the Calibration EEPROM using the

following procedure.

a. Call niSync Initialize External Calibration VI to initialize the

process.

@ Note NI is the default user password. If you have changed the calibration password, use
your user-selected calibration password in place of NT.

© National Instruments Corporation
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LabVIEW Block Diagram NI-SYNC C Function Call

Call nisync_InitExtCal with the
Iritialize External Calibration. vil following parameters:

resource hame [

----- ; instrument handle out resourceName: *<MAX [D>*
[abck :

password: NI

calibrationInstrumentHandle:
: *SessionHandle
T

b. Call niSync Adjust Oscillator Voltage VI to adjust the voltage of
the oscillator.

LabVIEW Block Diagram NI-SYNC C Function Call

Call
iS Adiust Dscillatar Voltage. vil niSync_CalAdjustOscillatorVoltage
: with the following parameters:

instrument handle in

inztrument handle out

vi: “<SessionHandle>"
0475 new Voltage: <new control voltage>
rror oud] oldVoltage: *oldvoltage

c. Call niSync Close External Calibration VI to commit the settings
and close the session.

LabVIEW Block Diagram NI-SYNC C Function Call

Call nisync_CloseExtCal with the
following parameter:

instrument handle in) [i5, e Close Extemal Calibration. vi]

vi: “<SessionHandle>"
action: NI SYNC_VAL_EXT_CAL_COMMIT

Erraf in rror oult]
Fm o K 50

NI PXle-6672 Calibration Procedure 12 ni.com



Reverification

After completing the adjustments to the NI PXIe-6672, it is important that
you verify the oscillator frequency operation by repeating the steps listed
in the Verification section. Re-verifying after making the adjustments
ensures that the NI PXIe-6672 is operating within its test limits.

National Instruments, NI, ni.com, and LabVIEW are trademarks of National Instruments Corporation.
Refer to the Terms of Use section on ni . com/legal for more information about National
Instruments trademarks. Other product and company names mentioned herein are trademarks or trade
names of their respective companies. For patents covering National Instruments products, refer to the
appropriate location: Help»Patents in your software, the patents . txt file on your CD, or
ni.com/patents.

© 2007 National Instruments Corporation. Al rights reserved. 372078A-01 Aug07
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